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Overview

This manual covers the installation and usage of SkIndigo, the SketchUp 

exporter for Indigo Renderer. By following the tutorials in this manual you 

should be able to export your scene in a high-quality way ready for Indigo to 

render.

Note that the SketchUp exporter is a very complex piece of software and not 

all the features are covered in depth by this manual. Refer to the Indigo 

Manual for detailed explanations of all the unique Indigo features. If a feature 

of SkIndigo is not described to your satisfaction, visit our forum and post a 

question and we will be happy to help you out. Our forum is available at:

http://www.indigorenderer.com/forum/

About exporters

Indigo is independent of modelling package and uses its own file format, 

called an Indigo Scene File (.igs). Before Indigo can render your scene, it 

must be converted into an .igs file. The job of an exporter is to create an .igs 

file from your currently open scene.

Acknowledgements

The SketchUp exporter is called 'SkIndigo' and is the result of the work of 

Dale Martens.  Glare Technologies would like to thank Dale for his original 

work on the project, and the ongoing support he provides to Glare.
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Installing SkIndigo

Step 1. Check your version of SketchUp

SkIndigo is compatible with release version 6 and version 7 of SketchUp, and 

works on both PC and Mac. You can download the latest release of SketchUp 

from:

http://sketchup.google.com/ 

Step 2. Download and install Indigo

Download Indigo for your system and install Indigo to the default location on 

your system.

http://www.indigorenderer.com/download/  

Step 3. Download and install SkIndigo

Download the version of SkIndigo for your system from:

http://www.indigorenderer.com/documentation/sketchup  

SkIndigo comes with an installer for Windows and Mac. Both installers will 

look for a “Plugins” directory in all known locations for SketchUp.

SkIndigo expects to find SketchUp at these locations:

Windows C:\Program Files\Google\Google SketchUp 7\

or C:\Program Files\Google\Google SketchUp 6\

Mac /Applications/Google SketchUp 7

Note: SkIndigo on Mac will only work on SketchUp versions 7 or above.
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If you have any issues installing SkIndigo, please email us at 

support@indigorender.com.

Restart SketchUp after installing SkIndigo and you should see see “SkIndigo” 

become available under the Plugins menu.

The SkIndigo Plugins menu

You are now ready to use SkIndigo.

Page 6



Things to know

There are several concepts you need to know to know to fully understand 

how Indigo works and how SkIndigo treats these concepts. Refer to the 

Indigo manual and the Techniques Manual for more detailed information.

Indigo is physically based

Indigo is a physically based renderer, that means that if is possible to 

construct a photo in the real world, it is possible to render it in Indigo. 

SkIndigo has the job of converting the virtual world of SketchUp into the real 

world representation used by Indigo. 

Users with experience of studio photography may find setting up a scene in 

Indigo a familiar experience.

Units of measurement

Indigo works on units of metres. SkIndigo by default converts on SketchUp 

unit of distance to one metre in real world space. Select an object and press n 

to see the position of the object in SketchUp units to get an idea of the scale 

of your scene. Because Indigo is a physically-based renderer, it is important 

that the scale is correct.

Light sources

SketchUp has some  light-sources that do not exist in the real-world – for 

example point lights (lights that are infinitesimally small and exceptionally 

bright) and 'invisible spotlights'. To use Indigo correctly you will need to 

master 'emitting materials' to create realistic lights in your scenes.
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Realistic Materials

Because Indigo is a photo-realistic renderer, the material properties of objects 

must be of a higher detail to accurately simulate them. This not only means 

higher resolution textures, but also correctly set material types that describe 

things about the material, such as transparency, roughness of the surface, 

and how light moves through the object.
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The Plugins Menu

The Plugins Menu is the primary place to access SkIndigo functionality, open 

dialogues and start rendering.

The SkIndigo Plugins menu

Render Scene

This exports the scene to an Indigo Scene File and launches Indigo to start 

Rendering.

Export Scene as..

Exports the current scene as an Indigo Scene File and prompts you  to 

choose a location to save to on your computer.  This is handy if you want to 

send a scene file to someone else, or upload it to a render-farm.

Export Sketchy Replay Animation

Exports an animation generated by Sketch Replay.  You should get the latest 

version of SketchyPhysics (a plugin by Chris Phillips) to use this feature.  For 

every object that you wish to animate, you must right click and 'Enable 

Instancing' for that Group or Component.
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Export Scene Tab Animation

Exports each scene tab as a separate frame in an animation. Creates Indigo 

Scene files for every frame and saves a batch file that progresses through 

them. Must have Halt (Render settings > Advanced) set to stop the 

rendering frame after a certain amount of seconds, or samples per pixel has 

been reached.  

Frame Rate: How many frames of animation per second to create for 

rendering. 

Smooth Transitions:  You have the option to smooth out the default linear 

SketchUp scene transitions to provide a more natural camera movement.

Render Settings

Opens the Render Settings window for configuring the Indigo export.

Material Editor

Opens the Material Editor window for creating and modifying Indigo materials 

inside SketchUp.

Query Material Types

Pops up a dialogue with all of the Indigo Materials in the current scene and 

the types of each material.

Set Light Layer Names

Specify names for the Light Layers. Useful for later reference.
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Set Indigo Path

If SkIndigo does not find Indigo in the default folder, then you can specify its 

location here. 

SkIndigo Toolbar

You'll notice a small toolbar added to your SketchUp layout also. These have 

the same functions as listed above.

Quick Export:  Use this option after you have finished modelling and 

applying materials to your model.  You must have exported your scene at 

least once before you can use this option.  This option will not re-export your 

meshes, thus making the export process much faster.  For example, if you 

have only changed your render settings or material settings since you last 

rendered, you should use the 'Quick Export' option.
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Material Editor

This is where you can add the unique Indigo material settings to your objects 

so they behave realistically. You can find it via: Plugins > SkIndigo 

Material Editor. 

The two GUI versions of the SkIndigo Material Editor (Simple left, normal right)

The general work-flow is that you paint an object with a SketchUp material, 

the select it with SkIndigo either by finding it in the drop-down at the top of 

the SkIndigo Material Editor, selecting it in the SketchUp material window or 

by right clicking on the object face that the material is applied to, and go 

down to SkIndigo > Edit “Material Name”.

If the SkIndigo menu is not in the right-click context menu, make sure you 

have just the mesh face selected, and not a group.
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1. Materials list

Here is where all the textures applied in your SketchUp scene are listed, 

choose the desired one to start creating a material out of it.

2. Main Menu

Import: Import a Indigo Material (.IGM). Use to bring in materials from the 

Material Editor.

Export: Export this material as an IGM or PIGM file which can be opened in 

the Indigo Material Editor or uploaded to the Indigo Material Database.

UI: This switches between the simple mode of SkIndigo, and the normal 

mode (See opposite). The simple view takes your settings and converts them 

as best as it can to normal settings. Normal mode is recommended. It is well 

worth your time to learn the Indigo Material Types as it allows you full control.

Preview: Uses Indigo to render a small preview view of the current material, 

shown in the preview pane below.

Search: Search the online material database and download free Indigo 

materials here. They need to be imported using the Import function after 

download.

3. Preview Pane

Shows the current material, the Preview function replaces this with a 

rendered scene with the material placed on the chosen model (to the right).
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4. Material Type

Select the Material Types from this drop-down list. Each has its own attributes 

that are listed below. 

Assign Preset: Choose a preset material from the list provided. This will 

replace any of the current material settings.

5. Material Attributes

Here is where the material attributes live. They allow you to add more details 

to your material. The list will change depending on the Material Type selected.

Explanations of the attributes are below.

Common material attributes

1.List of Material Attributes

2.Map: Where the information is sourced from.

None: Use only the value to the right (3.).

SketchUp: Use the SketchUp texture or color.

External: Used for texture maps (See below).

Shader: Uses the Indigo Shader Language (ISL) to generate a map.

3.Values: Changes the common value of this attribute. Usually a multiplier.

4.SkIndigo Texture Editor: Allows you to adjust the map used. See below 

for more information on its features.
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SkIndigo Texture Editor

Here you can make adjustments to the texture map used for both external 

and SketchUp map types. Press New to add a texture.

The SkIndigo Texture Editor

A – Quadratic: Scales values by a quadratic, so low values stay low, and 

larger values become exponentially larger. You will not often need to use this, 

usually it easier to get expected results by modifying the texture map with an 

image editing program.

B  - Multiplier: Scales the texture map values. Can be associated with 

contrast. 

C – Base Value: Makes the whole texture map brighter or darker.

Gamma: Used for converting texture RGB values to display values.  A typical 

value is thus 2.2.

UV Set: This references the UV sets for this face. See below for more 

information on UV mapping with SkIndigo.

Position Map: First, select any number of faces in your model.  Clicking this 

button will apply this texture to the selected faces so you can then position 

the texture using the SketchUp texture positioning tools.  Once you have 

positioned the texture, you can save the UV set using the right-click context 

menu.  Be sure to paint the desired material back to the selected faces before 

rendering.
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Material Settings

This is a brief description of the material types. As always, see the Indigo 

Manual for more detailed information. 

Simple UI Mode

SkIndigo Simple UI Mode

Reflection: Adds reflections to the surface, higher is means more light is 

reflected.

Roughness: Smoothness of reflection lower means more mirror-like, higher 

is more diffuse.

Transparent: Allows light to pass through the material.

Emitter: Turns the material into a light emitting surface.

Power: Strength of the light emissions.

Bump: Add a bump map. Does not displace the surface, just gives the 

illusion of a bumped surface.

Displace: Add a displacement map. Displaces the surface of the object with 

the material applied.

Clip: Add a clip map.
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Normal UI Mode

SkIndigo Normal UI Mode

Diffuse: Diffuse materials are flat, matte 

surfaces that don't have shiny edges. Flat 

wall paint, or a piece of paper are good 

examples of a diffuse material. There will be 

no particular reflection from a diffuse 

material.

Phong: Phong is a shiny material. 

Commonly used for shiny paints or any 

metals. In particular, phong will have a 

"specular highlight" where the light is 

completely reflected. Phong is useful for 

anything that has a lacquer applied to it - for 

example a shiny wood floor or a car paint.

Specular: Specular materials are quite 

powerful and can be made to act as perfect 

reflectors (like a mirror) or as a fully 

transparent glass and anything in between.
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Glossy Transparent: Gives a rough 

surface to a transparent material. Can be 

used for frosted glass.

Blend: The is a material type that lets you 

create compound materials that are a 

combination of other materials. Blended 

materials have a 'blend map' that specifies 

how to blend the two sub-materials 

together. For example, you might have a 

shiny phong material combined with a rusty 

diffuse material. The blend map would show 

where the rust spots show through.

Metals: Indigo comes with many Lab-

measured metals. Use Apply Preset to 

choose a metal from a short-list, or Nkdata 

for the full list of available metals.

Thin Glass: This is actually not a native 

Indigo material type.  It is actually exported 

as a blend between a null (invisible) 

material and a reflective Phong material. 

This material does not require the glass to 

be modelled as a volume.  However, it is not 

a physically accurate representation of 

glass.

Oren Nayar: Oren-Nayar materials are very 

rough materials that scatter light in every 

direction. They are rougher than diffuse 

materials. Oren-Nayar is useful for creating 

surfaces that are like clay, or generally 

rough. They aren't shiny at all. 
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Exit Portal: Exit portals are useful for speeding up interior renderings, when 

the interior is lit by an environmental light source, such as the sun/sky model.

Exit portals are placed over the openings between the interior and the 

exterior environment. These openings are the 'portals' in the scene.

Linked IGM: Link an Indigo Material file and replace the current material. 

Material attributes

Default settings for material type Diffuse

Selecting different material types will change the list of options below, some 

material types share the same channels as others. Here is a list of all material 

channels for all material types.

Albedo: The color of the surface, includes 

texture map.

Bump: Add a bump map. Does not displace 

the surface, just gives the illusion of a 

bumped surface.

Displacement: Add a displacement map. 

Displaces the surface of the object with the 

material applied.
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Emission: Emits light from the mesh 

surface. Used for all types of lights. Adjust 

parameters to change light color brightness.

IOR (Index Of Refraction): Basically 

controls the amount of light reflected by the 

surface.

Exponent: Controls the 'roughness' of the 

surface. The smoother the surface (or 

higher the IOR) the sharper the reflection.

Surface Color:  It absorbs light entering 

the medium at the surface. Useful to make 

stained-glass effects.

Sigma: Defines the roughness of the 

surface.

NK data is data from lab-measured metals.

Clip: Creates a clip-map, or alpha map. Useful for blending or making 

transparent areas.
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Media Attributes

Edit the Internal Medium of Specular and Glossy Transparent materials. The 

Internal Medium controls how light moves through the interior of the object.

Default settings for Media Attributes

Absorption: Controls which spectrum of light is absorbed. Effectively 

absorbs all colors of light other than the color specified.

Precedence: If more than one material is set to an object that have an 

internal medium set, then the medium with the highest precedence is used.

Cauchy B Coefficient: Controls dispersive refraction. Typical values for glass 

and water lie in the range 0.003 – 0.01. Use 0.0 unless absolutely necessary.

Subsurface Scattering: Scatters light. Input one value for a uniform 

scattering spectrum.  Input three values separated by spaces for an RGB 

scattering spectrum.

Phase Function: The phase function controls in which direction light is 

scattered, when a scattering event occurs.

Uniform: If enabled, scattering will be uniform in all directions.

Henyey – Greenstein: The Henyey-Greenstein phase function can be 

forwards or backwards scattering, depending on the 'g' parameter.

G Spectrum: This is the average cosine of the scattering angle.  Range 

should be between -1 (backward scatter) and +1 (forward scatter).  Enter 

three values separated by spaces for RGB spectrum.
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Right-click Context Menu

UV Mapping

UV mapping is the process of modifying the texture map to fit the model. 

SkIndigo supports 4 UV maps per mesh face, which means you can have a 

the texture map aligned one way, the bump a different way, and the clip map 

another way on every surface in your scene. 

SketchUp has a basic UV positioning function that is used to manipulate the 

textures. It is also very important that the faces are facing the right way, if 

the UV mapping function is not listed in the Right-click SkIndigo menu, then 

try reversing the faces.

1. Here is an example run-through on how to set a textured object with 

a differently positioned bump map:

2. Set the desired bump map as the albedo for positioning purposes.

3. Set the bump map position with the SketchUp tools (Rightclick > 

Texture > Position)

4. Rightclick > SkIndigo UV Mapping > Save UVs to set 2

5. Saving the current texture position to a UV set

6. Change the albedo to the actual albedo and the the bump to the 

bump.

7. Position the Albedo with the texture tools and save it as UV set 1.

Selecting the UV set in the texture editor
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8. In the SkIndigo Material editor, open the Texture Editor for the albedo 

and change the UV Set to 1. Set the bump map's UV Set to 2

9. Now it will use different texture positions for the albedo and bump 

map. Render to test.
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Instancing

Sang clone army

Instancing is a feature of Indigo that is used to copy an object as many times 

as you want without using any extra RAM. There are two ways to do it with 

SkIndigo.

The first and easy way:

1. Create an object and make it a group or component (Shortcut key: 

G)

2. Copy it and move it around (using the Move tool, hold ctrl and then 

moving copies it easily)

3. Copy, Scale, Rotate, Move the component as many times as you wish.

4. Select them all and Enable Instancing via the SkIndigo Right-Click 

menu.

The second way is by creating a proxy so that if you have a complicated 

component, it doesn't slow down your SketchUp scene.

1. Create the object you wish to copy, create a component out of it and 

name it “objectname”

2. Enable instancing on the component.
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3. Create a new object to use as a proxy (a cube will do) and create a 

component out of it named “objectname_dummy”. It is important 

that it has the name of the original component followed by “_dummy”

4. Copy and manipulate these dummies around the scene and on render 

they will be replaced by the original component.

Quick Export

See Quick Export.  
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Render Settings

The Render Settings Window configures the scene for export to Indigo. 

Find it at Plugins > SkIndigo > Render Settings

SkIndigo Render Settings

Apply Changes: Keep any changes you have made to the settings

Cancel Changes: Resets the settings to the last applied settings.

Reset Camera: Resets any changes to the camera

Save Defaults: Saves all current Render settings as default starting settings.

Output

Image Dimensions: Configures the width and height of the render to be 

created. Keep in mind that the free version of Indigo can only render images 

up to 1000x700 pixels in size.  You will need to order a licence to use higher 

resolutions.
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Region Rendering: Region rendering allows you to render only a small part 

of the scene. This is similar to moving the camera, but is useful when you 

need to focus the render on a part of the full image.

Save to .igi: Saves an IGI file for reach rendered scene. On by default.

Custom Image Name: Enable this to use a custom name for the PNG image 

that is automatically saved when rendering.

Watermark: Enable this to add the Indigo logo to the PNG image that is 

automatically saved when rendering. 

Image Name: To use this image name, the box above must be checked. 

Image Path: Renders will be auto-saved to this directory.

Thumbnail Path: Material preview images will be saved to this directory.

Auto-Save Period: Enter the time interval in seconds that the rendered 

image will be saved.

Tonemapping

SkIndigo Tonemapping settings

Tonemapping is a post-process that can be changed after, or during rendering 

in the Indigo GUI. Change settings here to save having to change them later.
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Reinhard: Like the auto-exposure on a digital camera

Pre-Scale: Scale the mid-gray point of the rendered pixels.

Post-Scale: Scale the white point of the rendered pixels.

Burn: Burn determines the luminance that clipping occurs. A smaller value 

means more severe burn.

Camera: These settings are just like on a SLR camera.

ISO: Select the film speed. Higher means brighter, lower means darker.

Shutter Speed: Select the reciprocal of the exposure time in seconds. Lower 

means longer, higher means faster.

Exposure: Select the exposure compensation (eV). Higher means brighter, 

lower means darker.

Response function: Emulates the type of effect given from camera 

selected.
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Camera

Skindigo Camera Render Settings

These settings control the Indigo Camera, they work as a real SLR camera 

does.

Aperture: Adjusts the size of the aperture of the Indigo Camera. Measured 

in F-stop. Larger F-stop means larger depth of field. 

Depth of field effect

Autofocus:  Sets the focal distance to the distance from the camera straight 

forward to the first object it sees.

Page 29



White Point: Adjust the White Point to get rid of colored tinges to an image. 

Can be changed during or after rendering in the Indigo Renderer.

Shift Lens; Up Shift, Right Shift: Shifts the lens in the camera to 

compensate for perspective distortions. 

Aperture Diffraction: Aperture diffraction allows the simulation of light 

diffraction through the camera aperture. Such diffraction creates a distinct 

'glare' effect around bright light sources in the image.

Aperture Shape:  This allows a particular shape of camera aperture to be 

specified. 

Blade OffSet; Blade Radius; Rotation Angle: Settings for generated 

aperture.

Aperture Map: Use a texture map as an aperture for the camera.

Use Obstacle Map:  An obstacle map texture is used when calculating the 

diffraction though the camera aperture. Use to change the way the aperture 

diffraction appears.
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Environment

Skindigo Environment Render Settings

These settings control the background of your scene. They all contribute a 

certain amount of light to the scene.

Sun and Sky

 Use Indigo's Sun & Sky model. Use SketchUp's Shadow feature via Window 

> Shadows to control the direction of the sun interactively. 

Turbidity: Controls the 'Haziness' of the sky. A larger value will be more 

hazy.

Sun Layer: What light layer to put the Sun's light contributions on.

Sky Layer: What light layer to put the Sky's light contributions on.

Override Sun Position; Set Sun Position: Set the sun position manually.
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Indigo's sun & sky

SketchUp Background Color

 Use the background color set in SketchUp. Change it via Window > Styles 

> In Model (drop-down) > Edit > Background.

Background colour

Page 32



Environment Map

 Use a HDR image as the background and to light the scene. 

Environment map

Gain:  The environment map is scaled by this factor when it is loaded.

Rotation: Adjust the rotation of the environment map about the up-axis

Type: Use Lat/Long for EXR probes, Spherical for FLOAT probes.

Width: The input width (pixels) of the Spherical Probe

Layer: Which layer the environment map will emit on.
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Advanced

Skindigo Advanced Render Settings

Tracing Method: If you are not sure which to use, PathTracing with BiDir is 

recommended.

MNCR: Max Number of Consecutive Rejections used in MLT tracing methods. 

A lower number will reduce 'fireflies', but will introduce some bias into the 

render.

Info Overlay: This will add an information bar to the autosaved renders.

Supersample Factor: This controls the amount supersampling. Numbers 

greater than one use more ram but reduce aliasing and fireflies.

Threads: Choose the number of CPU threads for Indigo to render with.

Auto Choose Threads: Automatically choose all available threads to render 

with.

Low CPU Priority: Indigo will start with Low priority, allowing it to render 

only when there is no other programs using the CPU.

Halt: Indigo will stop rendering after the set amount of seconds, of SSP 

(samples per pixel) and wait for the user to same the image.

Network rendering Mode: This will set Indigo to render over the network 

with available slaves. Working Master renders the current scene along with 

coordinating the slaves. Network master only coordinates slaves.

Frame Upload Period: The time in seconds between uploads from the 

slaves to the master.
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Creating a sample scene in SkIndigo

This tutorial goes over generating a simple scene and lighting it a few 

different ways. The scene will be a typical German apartment with white 

walls, wood flooring and some furniture from Ikea. We won't be modelling the 

garage with an Audi, dog called Schatzi and traditional lederhosen.

This tutorial was done for SketchUp 7 free version, your SketchUp may look 

slightly different. A basic level of knowledge of using SketchUp is required.

Step 1. Create the basic room

First up we will model the room. Start by drawing a rectangle   on the 

ground and another rectangle just inside it. Your rectangle should be 12 

metres by 12 metres, look at the dimensions box in the bottom right of your 

window to see the size as you drag the box out.

The ground plan of our room

Next, use the push/pull tool  to make the walls 4 metres high. We won't 

put a roof on the box just yet so that we can see inside it. Next step is to put 

a big floor-to-ceiling window at the front of our box. Use the rectangle tool to 

draw a rectangle on the front of the box, then use the push / pool tool to 

push the new rectangle inwards until the wall is paper thin.

Our room with a paper thin front wall.
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Now click on the paper thin wall and delete it. Don't delete the line at the top 

of your room, we'll need that in a second. Now press Plugins  Skindigo → → 

Render and you will get a render like this:

Bryce standing outside his new house

Step 2. Add window and roof 

For the next step, we will add a roof and a window and set a wooden texture 

on the floor and a glass window. Start by using the rectangle tool to enclose 

the roof. Then draw a rectangle on the wall of the left hand side and use the 

push / pull tool to push the rectangle through to the inside. Delete the paper 

thin wall that is left and you should have a window hole like so:

Our box room with a window and a roof.

As a final step, use the Move tool   to put Bryce somewhere side your 

house.
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Step 3. Paint a wood texture on the floor

Next, press the Paint Bucket tool  and the SketchUp materials dialog will 

open. Select wood from the selection box:

Selecting the wood textures that come with SketchUp

Now choose wood_floor_light  as a texture. Then click on the floor. 

Your floor will now be textured. Zoom in the camera a little and hit render – 

your house should look like this:

Bryce in his new house with a roof, window and a floor.

Now right click on the floor and select Texture  Position→ . Rotate the wood 

texture 90”. You can also scale the wood texture if you want.
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Step 4. Add some carpet

Carpet is a tricky thing to model because it has so many individual fibres. The 

best way of creating a carpet in SkIndigo is to use what is called a 

displacement map.

Start by drawing a rectangle on the floor and using push/pull to make it into a 

box of 3cm height. Then use the select tool  to select the top and 4 sides 

of the box and select Edit  Make Group→ .

When we add a displacement map, it will make our 'carpet box' very bumpy, 

which means the edges of the box won't line up. To prevent gaps appearing, 

right click on the carpet and select Soften / Smooth Edges, choose a value 

of 80' between normals and press enter.

Our carpet box ready to texture map.

Now using the paintbrush tool, select the Carpets and Textiles set and the 

Carpet_Plush_Charcoal texture. Apply it to the carpet box. Right click on 

the carpet box and choose SkIndigo  Edit [Carpet_Plush_Charcoal]→ .

The SkIndigo Material Editor will open:
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SketchUp material editor

Note that the Albedo channel (which means the color of the material) is 

already set to the SketchUp carpet texture. 

Click on the drop down next to Displace, and change None to SketchUp. This 

will make the displacement map use the same carpet texture. Set the value 

to 0.03 – this sets the height of the carpet to 3cm. 

Press  Plugins  Skindigo  Render Scene→ → , you will note that the carpet 

looks all triangulated and bumpy. You need to increase the 'detail' of the 

carpet. Back in the SkIndigo Material Editor, under Mesh Subdivision, 

increase  Max Subdivions from 6 to 8. Render the scene again.
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Bryce admires his nice grey carpet

Step 5. Add a chair and lamp

Use Windows  Components → menu to show the components window. 

Search for Barcelona chair and insert one into the scene. Then search for 

Kare 5701 (a lamp) and insert it into the scene too.   

Scene with a lamp and chair added.

Double click on the lamp to edit it – then in the Material Window click New 

Material   to create a new material. Name this material 'Chrome' and 

apply it to all of the surfaces of the lamp (Use Edit  Select All→ , then use the 

Paint Tool to apply the material).
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Right click on the lamp and select SkIndigo  Edit [Chrome]→ . We will use 

an external Indigo material on the lamp. Load the following URL in your web 

browser:

>> http://indigorenderer.com/materials/materials/55 

Download the material to your Desktop, then go back to the SkIndigo 

Material Editor and press Load.

Load button is on the left.

Browse to the Brushed_Metal.pigm file you just downloaded and select it. 

Now render the scene – it should look like this:

Lamp has a shiny material applied.

Step 6. Adding nightime lighting

Now we will try adding a lightbulb inside the lamp and taking a night scene. 

Start by turning off the sun by going to Plugins  SkIndigo  Render→ →  

Settings, then Environment. Select SketchUp background color and make 

sure Black is selected like so:

Setting SkIndigo to render a night scene
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Now we need to add a light inside the lamp. Double click the lamp to edit it, 

then look inside the lampshade and create or select the lighbulb inside it 

(your lamp may look slightly different, you may have to create the lightbulb 

yourself). 

Create a new material called LightBulb.

Lightbulb with a yellow LightBulb material applied to it.

Right click on the bulb SkIndigo  Edit [LightBulb] material→ , then click 

'Assign Preset' and scroll down to the bottom of the list of preset materials. 

Select the 100W incandescent bulb and close the 'presets' window. You can 

change the power of the bulb under the 'emissions' section of the SkIndigo 

Material Editor.
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Physically correct lighting, this is how a 50 Watt bulb would look.

Step 7. Finetuning

The trick to getting really realistic renders from SketchUp + Indigo is to 

spend time tweaking your materials until they look just right. In this example 

I have used models from the Google Warehouse that are relatively low in 

polygon count, so don't look ultra realistic, but by carefully editing the 

materials used on the models you can make the scene look better and better.

One of the advantages of Indigo is that if you set a 100 Watt lightbulb in a 

lamp, you can see how the light will fall off around the room, useful for doing 

lighting analysis – will you need more light fittings in the corner of the room?

To increase the realism of this scene, you could:

•Increase the Mesh Subdivision of the carpet to 10. This will make the 

carpet seem finer grained and more 'fluffy'.

•Reduce the 'exponent' of the chrome material to make the floor lamp less 

reflective.

•Use the 'material type' drop-down to change the floor material to  a 'phong' 

material. Phong materials are 'shiny' materials, and this will make the floor 

look more like a lacquer. 

•Add a bump map to the floor material, of height 0.1 centimetres, to 

simulate the grain of the wood.
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•Increase atmospheric scattering in the sun / sky model to make it look 

like a more cloudy day.

As you can see there are  many options that you can tweak to get the best 

possible results out of Indigo. 

Creating ultra realistic scenes that look like something from the real world is 

usually achieved by recreating all of the models in the scene with accurate 

geometry, and then spending 30-40% of your time modifying materials in the 

scene to ensure that they are as realistic as you would like them to be.

We hope you have enjoyed this brief introduction to SkIndigo. 
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Going Further

You are now ready to start exploring SketchUp and Indigo. To learn more 

about using Indigo – see these resources.

The Indigo website:

http://www.indigorenderer.com/  

The Indigo materials database:

http://www.indigorenderer.com/materials/  

The Indigo forums are a lively place of debate - you should especially take a 

look at the SketchUp sub-forum.

http://www.indigorenderer.com/forums/  

If you need support, please email:

support@indiorenderer.com  

We hope you enjoy using Indigo and look forward to seeing your renders! 
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